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Chapter 1: About the Data Analysis Software

Program Description
The C&L Data Analysis package is an easy-to-use 32-bit software application designed for
use with the C&L Dye Fluorometer.  It offers powerful data analysis features using a
standard Windows  interface.  The software allows the user to:

! View data from your experiments, collected with the C&L Dye Fluorometer and the
Data Acquisition software

! Analyze the fluorescence and analog data from your experiments

! Export data to other software programs such as Microsoft Excel

! Run concurrently with the C&L Instruments Data Acquisition Software, in another
program window, so you can analyze one experiment while taking data from another

System Requirements
The Dye Fluorometer software requires the following minimum configuration:

! Pentium® 133 MHz computer

! Windows® 95 or Windows® 98 operating system

! 16 MB of RAM (32 MB recommended)

! Mouse input device

Screen resolution of 600 x 800 pixels (or greater) with 256 colors (or greater) is
recommended.

Technical Support
If you run into problems while using Data Analysis, first check Chapter 7:
Troubleshooting for solutions to common problems.  For additional support, and to report
software bugs or documentation errors, contact C&L Instruments.  Contact information is
listed on the front cover of this manual.

About this Manual

What’s Covered

This manual covers the installation and operation of C&L’s Data Analysis software. It is
assumed that the user is already familiar with the following:

Fluorescence spectroscopy concepts and procedures

How to use Windows® 95 or Windows® 98
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The other hardware components of the C&L Dye Fluorometer.  The operation of these
components is covered in separate user manuals.  It is recommended that the user become
familiar with operating the C&L Dye Fluorometer hardware prior to using this software.

Obtaining Current Documentation

The most current version of the Data Analysis User Manual is available for downloading
at the C&L Instruments, Inc. Web site. See the front cover of this manual for the URL.

.
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Chapter 2: Software and Hardware Installation

Overview
This chapter explains how to install the PC card into the host computer and install the
Data Acquisition software.

Installing the Hardware

Installing the PC-DAQ Controller Card

If you did not purchase a computer from C&L Instruments along with the C&L Dye
Fluorometer, you will need to install the PC-DAQ Controller card and software in your
computer.

The PC-DAQ Controller card is a 16-bit ISA card.  It can operate in two modes: Plug and
Play (PnP) and non-Plug and Play (non-PnP).  Non-PnP is sometimes called legacy mode.
In PnP mode, the installation process is automatic, in that the Windows operating system
will assign the necessary hardware interrupt (IRQ) and base address to the PC-DAQ
Controller card without user intervention.  In non-Plug and Play mode, the user must set
jumpers and switches on the Controller card to manually set the hardware interrupt and
base address.  The non-PnP mode is generally reserved for special cases when a resource
conflict in the computer must be resolved by manual intervention by the user.

It is recommended that the user install the PC-DAQ Controller card in PnP mode.  In this
mode, the installation is considerably easier, and the operating system automatically
assigns resources to the card.  The following instructions outline the procedure to install
the PC-DAQ Controller card in the PnP mode.  Contact C&L Instruments for instructions
for installing the card in non-PnP mode.

To install the PC-DAQ Controller card in PnP mode, follow these steps:

1. Turn off all electrical power to the computer.

2. Open the computer case.  Refer to the manual that came with your computer if you
do not know how to open the computer case.

3. Install the PC-DAQ controller card in an empty ISA slot. Note that the Controller
card has one single jumper in the lower left side of the card (Jumper J11).  This
jumper must be off (i.e., open position) to select PnP mode.  Secure the card in the
chassis using the hardware provided by the computer manufacturer.  Usually one
screw is used to hold an ISA card in place.

4. Close the computer case.

5. Start the computer.

When the computer restarts for the first time after installing the PC-DAQ Controller card,
Windows should find the new hardware and report:
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“New Hardware Found  -  ISA PnP S48C Data Acquisition”

Follow the instructions by Windows.  When prompted for location of the driver, insert the
floppy disk comes with the PC-DAQ Controller card and direct Windows to install the
driver from the floppy disk.

To make sure the card is installed correctly, open the Control Panel (in the Start menu,
under Settings / Control Panel).  Select System, and then the Hardware Manager tab.
There should be an entry indicating “Virtual Motor Driver” under the “C&L Instruments”.
Select the device with the left mouse button and check the Properties of the device.
Windows should have assigned resources to the PnP Controller card.  Windows may
report something similar to the following:

Interrupt Request  05

Input/Output Range  0280-02BF

The Interrupt Request and Input/Output Range assigned to the PC-DAQ Controller in your
computer may differ from the above example.

Note: The current device driver supplied with your PC-DAQ Controller card has been
fully tested with Windows 95 version 4.00.950, Windows 95 version 4.00.950 B (OSR2),
Windows 98, and Windows 98 Second Edition.  If you upgrade or install a new operating
system, it is recommended that you open the computer case and remove the card from the
computer before you start the upgrade or installation.  After the upgrade or installation is
complete, reinstall the PC-DAQ card.

Installing the Data Acquisition Software

After installing the PC-DAQ Controller card in your computer, you need to install the
Data Acquisition Software.  To install the Data Acquisition software, follow these steps:

Insert the diskette provided by C&L Instruments.

Using the Run… command in the Windows Start menu, launch the Setup.exe program
provided on the diskette.

Follow the installation directions on the screen.  Read the License Agreement that is
displayed by Setup.

When the software installation is complete, several system files will be stored in the
Windows/System directory.  The main C&L Dye Fluorometer software files and the
default configuration file will be placed in subdirectory structure under either the
C:\Program Files\CandL directory created by Setup or the directory you specified during
the installation process.  Reboot the computer before using Data Acquisition for the first
time.
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Chapter 3: Getting Started

Overview
This chapter will quickly familiarize the user with the basic operating steps required for
analyzing data collected with the C&L Instruments Dye Fluorometer. It is recommended
that the user be familiar with the data acquisition procedures and C&L Instruments Dye
Fluorometer operation described in the Data Acquisition software manual.

Further details about viewing and analyzing data are provided in the following chapters,
which describe all available software features and explain how they are used to view and
analyze data.  The user is encouraged to read these chapters so that the many powerful
features of the data analysis software can be utilized to their fullest potential.

Basic Steps in Data Analysis
To begin a data analysis session, there are only four basic steps to follow.

1. Turn on your PC and Monitor

2. Launch the Data Analysis software.

3. Open the data files from a previously recorded data acquisition session.

4. Apply data analysis functions to interpret your data.

Figure 1.  Program window as it appears when you open the file Test.flu, showing the toolbar,
status bar, and 4 child windows.
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Chapter 4: Command Reference

Overview
This chapter describes in detail all features of the Data Analysis software that are available
to the user.  The user has control over how the Dye Fluorometer views and analyzes data
by specifying various File, Edit, Options, View, Window, Function and Display options
in the Data Analysis software.

The following features are covered, in the listed order:

! Main program window and child windows

! Drop-down menu bar and individual drop-down menu items

! Toolbar

! Status bar

Main Program Window and Child Windows
The Data Analysis program opens as one main program window containing a typical
Windows title bar and a drop-down menu bar.

When the Data Analysis program is first started, the Window is in ready mode for you to
load a data file of a previously recorded session from disc. Included with the program files
is a file named “Test.flu”. This file is available in the “data files” folder to demonstrate the
features of the analysis software. You may access the file from the File menu or the “open
file” icon.

Drop-down Menu Bar
Under the program title bar is the drop-down menu bar, which contains the following
menus: File, View, Window and Help. When you open a data file, the Options and
Functions menus are activated. Through these drop-down menus, all features of the Data
Analysis software can be accessed. In addition, some menu options are also available
through icons displayed in the toolbar.

The drop-down menus serve the following functions. Each menu is described in greater
detail in the following sections.

•  File - Allows the user to Open and Save files, Print the contents of data windows, and
Exit the program.

•  Edit – Allows the user to Copy the viewed data into the Windows  clipboard. Edit is
only available when Fluorescence Counts, Fluorescence Ratio, Analog, Ion
Concentration, or Interlace child windows are active.

•  View - Allows the user to toggle the main program window’s Toolbar and Status Bar
on and off.  Also allows the user to perform various actions to manipulate the
presentation of data in the active Fluorescence, Fluorescence Ratio, or Analog
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windows.  These actions include Zoom, Unzoom or Move the scale of the Y-axis, and
change the Settings… of the zoom function, Select X to select a region of interest, and
Sync Time. When an FFT window is active, you can choose to include or exclude the
DC component with the DC command.

•  Options - Allows the user to specify the display Color of various channels and text.

•  Function – Allows the user to access data analysis functions which are detailed later
in this chapter. These include: Downsample, Filter, Interlace, Savitzky-Golay analysis,
Fluorescence Ratio and Ion Concentration calculation. The Settings command gives
access to the parameters used in the respective functions.

•  Window - Allows the user to open New Fluorescence, New Analog, or New
Fluorescence Ratio, New Data Statistics, or New Spreadsheet data windows.  Also
allows the user to select the active window and to arrange the child windows within
the main program widow using the Cascade, Tile and Arrange Icons options.

•  Help - Allows the user to access on-line information About Analysis.

File Menu
The File menu contains the following options:

! Open...,

! Save,

! Save As...,

! Print...,

! Print Preview,

! Print Setup...,

! 1 [filename] (etc.)

! Exit

These options are described in detail below.

File / Open…

Opens a dialog box in which the user can locate and open a specific data file.  Data files
are stored with the .flu extension.

File / Save

Saves the data file using the same file name.

File / Save As…

Opens a dialog box in which the user can save the data file using a new file name.
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File / Print...

Prints the contents of the active window.

File / Print Preview

Allows the user to preview the output of the Print command on the monitor screen prior to
printing.

File / Print Setup...

Allows the user to change the printer device and to specify other print options available
through the printer driver.

File / 1. [file name] (Etc.)

Displays the list of the most recently used data files.  Selecting one of these file names
provides a shortcut for opening previously used C&L Dye Fluorometer data files.

File / Exit

Terminates the Data Analysis program.

Edit Menu
Allows the user to Copy the viewed data into the Windows  clipboard. Edit is only
available when Fluorescence Counts, Fluorescence Ratio, Analog, Ion Concentration, or
Interlace child windows are active.

View Menu
The View menu allows the user to control how data is viewed in the main program
window and data windows. The View menu options vary depending on the type of
window that is currently active.

If an information window is active, such as Data Information or Statistics, the following
menu options are available in the View menu.

! Tool Bar

! Status Bar

If an Analog window is active, the following menu options are available in the View
menu.

! Tool Bar

! Status Bar

! Zoom >Range, In, Out

! Move >Up, Down, Left, Right

! Unzoom
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! Settings

! Circles

! Lines

! Sync Time

If a Fluorescence Ratio window is active, the following menu options are available in the
View menu.

! Tool Bar

! Status Bar

! Zoom >Range, In, Out

! Move >Up, Down, Left, Right

! Unzoom

! Settings

! Circles

! Lines

! Sync Time

If a Fluorescence window is active, the following menu options are available in the View
menu.

! Tool Bar

! Status Bar

! Circles

! Lines

! Zoom >Range, In, Out

! Move >Up, Down, Left, Right

! Select X

! Unzoom

! Settings

! Sync Time

! Counts

! Counts / sec
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Accessing the Filter function generates a window displaying a Fast Fourier Transform
(FFT). If an FFT window is active, the following menu options are available in the View
menu.

! Tool Bar

! Status Bar

! Circles

! Lines

! DC

! Zoom >Range, In, Out

! Move >Up, Down, Left, Right

! Select X

! Unzoom

! Settings

! Sync Time

! Counts

! Counts / sec

If an Interlace window is active, the following menu items are available in the View menu.

! Tool Bar

! Status Bar

! Circles

! Lines

View Menu Commands:

View / Tool Bar

Displays or hides the Tool Bar.

View / Status Bar

Displays or hides the Status Bar.

View / Counts and View / Counts/Sec

Changes the units on the Y-axis in the active Fluorescence data window.

! Selecting Counts changes the units to (Fluorescence) Counts. This represents the
number of photon counts collected by the detector within the sampling period.
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! Selecting Counts/Sec changes the units to Counts/Second. This represents the
number of photon counts collected by the detector within a sampling period, but
expressed on a per second basis.

View / Zoom Range, Zoom / In, Zoom / Out, / Move /  Up,  / Move /  Down,  /
Move /  Left,  / Move /  Right, and  / Select X

The Zoom Range, Zoom In, Zoom Out, Move Up, Move Down, Move Left, Move
Right, and Select X options are used to control the display of data in the Fluorescence,
Analog and Fluorescence Ratio windows.  When one of these menu options is selected,
the mouse cursor changes from the standard pointer to an icon indicating the selected
option.  The new mouse cursor is visible only when the mouse is moved over the
Fluorescence, Analog or Fluorescence Ratio windows.

! When the Zoom Range command is selected, the cursor changes to a rectangle.  With
this tool the left mouse button can then be used to select a rectangular window to zoom
in to.

! When Zoom In is selected, the mouse cursor changes to a magnifying glass containing
a plus sign.  The left mouse button can then be used to zoom in on any area of interest
in Fluorescence, Analog and Fluorescence Ratio windows.

! When Zoom Out is selected, the mouse cursor changes to a magnifying glass
containing a minus sign.  The left mouse button can then be used to zoom out of any
area of interest in Fluorescence, Analog and Fluorescence Ratio windows.

! When Move Up is selected, the mouse cursor changes to an upward pointing arrow.
The left mouse button can then be used to move the data displayed in the
Fluorescence, Analog and Fluorescence Ratio windows in an upward direction.  The
data can only be moved upward after the Zoom In function has been performed and
only if the display is not already at its upper limit.

! When Move Down is selected, the mouse cursor changes to a downward pointing
arrow.  The left mouse button can then be used to move the data displayed in the
Fluorescence, Analog and Fluorescence Ratio windows in a downward direction.  The
data can only be moved downward after the Zoom In function has been performed and
only if the display is not already at its lower limit.

! When Select X is selected, a Region Of Interest (ROI) can be selected using the left
mouse button. The selected ROI is indicated as a red bar that is visible under the X
axis of each data window.  This feature is used to select a ROI for the available
functions.

! The ROI data will be analyzed and displayed in the Statistics window.  The Statistics
window indicates the range of points selected in the ROI, the mean of each channel
and the equation for the best fit line through the data of each channel.  In the Analog or
Fluorescence windows, the ROI selected will be the data range used for frequency
analysis in the FFT window and the data range used in the Interlace window.
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! If the ROI is selected in the FFT window, then the Analog and Fluorescence windows
are updated with the results of the selected filter.  Depending in the settings of this
function, the ROI is used to select either a passband or notch region in the frequency
spectrum.

View / Unzoom

Unzoom restores the full view of the data in the window.

Shortcuts to the Zoom Range, Zoom In, Zoom Out, Move Up, Move Down, Move Left,
Move Right, Select X and Unzoom features are also available in the icon bar.

View / Settings...

The Settings command gives access to dialog boxes which set the parameters for Zoom,
and allows the user to specify which values are displayed on each axis. The user may enter
values for each axis and the Region Of Interest (Select X) directly in the dialog boxes
instead of designating the positions with the cursor. The Zoom ratio is the percent increase
in magnification scale when a zoom command is issued, and may be specified
independently for the X and Y-axes. The Zoom ratio on top is the X-axis and the one on
the bottom is the Y-axis. The ratio settings may be saved by clicking the Save current
ratio button.

! Circles

Displays data points as circles.

! Lines

Connects data points with lines.

Shortcuts to the Circles and Lines commands are available in the toolbar.

! DC

The DC command toggles the DC component in the FFT window on or off. This is
useful when you want to display an FFT without the usually large DC component that
would otherwise distort the scale of the frequencies. Turning DC off will cause the
FFT window to display only the AC component of the signal.

! Sync Time

The Sync Time command is used to synchronize the time axes for all windows so that
changes in one will be reflected in the others.

A shortcut to Sync Time is available in the toolbar.

! Sync Frequency

The Sync Frequency command is used to synchronize the frequency axes of multiple
FFT windows.
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Options Menu
The Options menu contains the following menu items:

! Color…

! Sequential

! Aligned

! Acquisition

! Compact

These options are described in detail below.

Options / Color… and the Color Dialog Box

Opens the Color Dialog box.

The Color Dialog box is used to change the color of the data points and text displayed in
the Fluorescence, Fluorescence Ratio and Analog data windows.  Up to eight channels of
data can be displayed in each Fluorescence and Analog data window.

Figure 2.  The Color Dialog box.

Selecting Channel Color

Clicking on the button for the desired channel in the Channel Color section displays a
standard Windows  Color selection dialog box.  The same Channel colors are used in
both the Fluorescence and Analog data windows.  The color selected for #1 (i.e.,
Channel 1) is used for the display of the fluorescence ratio in the Fluorescence Ratio
window. The default setting assigns unique colors to each channel.
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Selecting Text Color

Clicking on Text allows the user to change the color of the text that appears in the data
windows. The same text color is used in the Fluorescence, Analog and Fluorescence
Ratio windows.

Accepting and Canceling Changes

Clicking on the Default button will revert all color changes to their default setting.

Clicking on OK closes the Color Dialog Box and saves all changes.

Clicking on Cancel cancels all changes and causes the colors to remain the way they
were prior to opening the Color Dialog box.

If desired, the user can also change the background color of the data windows.  This is
accomplished by editing the Properties of the Windows  desktop.  Further instructions
can be found in the Windows® 95 user manual.

Sequential, Aligned, Acquisition, and Compact options are available when a file is
loaded that was collected under Mixed (random access filter positions) Mode.  These
selections work together to allow you to change the manner that the data is displayed.
These selections do not alter the data, only their display. Sequential and Aligned
change the alignment of the data with respect to the time axis. Acquisition, and
Compact change the display between two representations to illustrate the data either
as acquired or as an average.

The Sequential command shows the Mixed Mode data with an advancing time index
such that each filter wheel position is rendered sequentially. Along the time axis, at
any time, there will be counts for only one filter position displayed.  This display
method illustrates an accurate temporal representation of the data as it was originally
acquired.

The Aligned command is the alternate for the Sequential command. In Aligned mode,
the data are displayed with the first data point of each filter position aligned at the
same time index, the time of the first channel selected. The counts may be
superimposed if the count level is the same in two or more filter positions,.

The Acquisition command displays all the data for each filter position.

The Compact command is the alternate for the Acquisition command. Compact
takes the data for each filter position and averages them and then displays the average
as one point only.

These commands may be used in a total of four combinations, Sequential with
Acquisition or Compact and Aligned with Acquisition or Compact.
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Figure 3.  A fluorescence window with data displayed in the Sequential and Acquisition
mode.  Data points are displayed as Circles as chosen in the View menu.

Figure 4.  A fluorescence window with data displayed in Aligned and Acquisition mode.
Data points are displayed as Circles as chosen in the View menu.
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Figure 5.  A Fluorescence window with data displayed in Aligned and Compact mode.
Data points are displayed as Circles as chosen in the View menu.

Functions Menu
The Functions menu allows the user to access data analysis functions for curve fitting and
smoothing as well as Fluorescence Ratio and Ion Concentration calculations. In order to
access the parameters used in the functions, select the Settings command.

The Functions menu contains the following items:

! Downsample

! Filter

! Interlace

! Savitzky-Golay

! Fluorescence Ratio

! Ion Concentration

! Settings

! Save Settings

These options are described in detail below.

Downsample

The Downsample Function is a data smoothing routine, which is similar to a running
average. It is generally used when the data is slowly varying, and you wish to consolidate
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the display and data file by eliminating redundant information. The Downsample factor,
which is selected in the Settings menu, determines the number of points which are taken
as an average. The averages are then plotted as the new display. A downsample factor of 1
would leave the display unchanged, while a downsample factor of 10 would reduce the
number of points displayed by a factor of 10.

Once the data has been downsample by a specific factor, reapplying the function will not
change the display unless the factor is changed.  Applying a downsample factor of 1 will
restore the original data.

The Downsample function is disabled when data files collected with the Single Sample
Mode are loaded into the Data Analysis program.  See Chapter 6: Viewing, Analyzing
and Saving Data for further discussion of the Single Sample Mode.

Filter

The Filter command performs an FFT (Fast Fourier Transform) on the data and displays a
new window with the results. The results are the data displayed in the frequency domain
from zero Hertz (i.e., the DC component) up to the Nyquist frequency. The Nyquist
frequency is determined by the rate of data acquisition and it cannot be changed after the
data has been collected.

Figure 6.  FFT window of the data in Analog 2 channel using the Test.flu data file
displayed with the DC component and Lines turned on.

You may choose a pass filter or notch filter from the Settings dialog box. In the FFT
display window, the bandpass or notch region is chosen with the Select X command from
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the View menu. When the FFT window is active, you can select to include or exclude the
DC component from the View menu with the DC command.

The Region of Interest in the FFT window is selected using the Select X command in the
same manner as used in other data windows. In the FFT window, the data segment
illustrating the selected ROI is shown with the chosen display color while the remaining
range is “grayed” out. After the ROI is selected in the FFT window, the data in the
Fluorescence or Analog window is updated in accordance with the frequency range
selected in the FFT window.

The Filter function is disabled when data files collected with the Single Sample Mode are
loaded into the Data Analysis program.  See Chapter 6: Viewing, Analyzing and Saving
Data for further discussion of the Single Sample Mode.

Interlace

The Interlace function is applied as a means of data analysis that can be used when data
from a repetitive event has been collected.  To use this function, the data must be acquired
in synchrony with the timing of the repetitive event.  The Dye Fluorometer allows you to
synchronize the multiwavelength data acquisition sequence (Multiwavelength mode) of
the fluorometer with an external stimulus, such as a cardiac cycle or nerve depolarization.
The user is referred to the Data Acquisition User Manual for instructions of how to set up
the Dye Fluorometer for synchronous data acquisition.

Since the Dye Fluorometer is a time-sharing device, data points collected at different
wavelength setting cannot be obtained at the same instant in time. As a result, a ratio
between the fluorescence intensities measured at two wavelengths may be in error because
the numerator and denominator of the ratio were measured at different times. The extent
of this error depends on the rate of data acquisition and the rate in which the data in
changing. These errors are insignificant at high rates of data acquisition or when the
fluorescence of the sample is changing slowly. One method of circumventing this error is
by collecting the data in a synchronous fashion and applying the Interlace signal
processing function.

The Interlace function allows you to obtain the data from the same point in time of all
measured channels as if the data from all channels were actually collected instantaneously.
The Interlace function uses a sampling technique to obtain these data from different
cycles of the repetitive event in order to reconstruct the repetitive cycle at all wavelengths.
This can be applied, for example, if you want a fluorescence ratio from a cyclically
varying event.

In the Settings for the Interlace function, you enter the Repetition Frequency (in
cycles/second) of the event when the data was originally acquired. The Sample Frequency
is calculated by the software and is based on the rate of data acquisition used when the file
was collected. Selecting the Apply button will return the Number of Samples that will be
derived within each cycle. The Number of Cycles indicates the number of repetitive events
that are required to calculate one data point at each time point in the repetitive cycle. This
represents the minimal number of cycles that must be acquired during the data acquisition
process and selected using the Region of Interest function in the Data Analysis program.
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Applying the Interlace function will derive the fluorescence data and standard deviation
for each wavelength during one cycle of the repetitive event.  The reader may reference an
article by Scott, et al. “Ratiometric measurement of rat heart NAD(P)H by Surface
Fluorescence,” American Journal of Physiology 267: H636-H644, 1994, for a further
discussion of this technique.

The Interlace function is disabled when data files collected with the Single Sample Mode
are loaded into the Data Analysis program.  See Chapter 6: Viewing, Analyzing and
Saving Data for further discussion of the Single Sample Mode.

Figure 7.  Results of the Interlace function when applied to a data segment of the Test.flu
file using the Repetitive Frequency of 5.  Each cycle lasts 0.2 seconds.  Shown is the mean
and standard deviation of the data in Analog channel 2.

Savitzky-Golay

The Savitzky-Golay function invokes a data smoothing routine. The function returns a
new data set of smoothed data using a least-squares procedure. It is designed to remove
extraneous noise and erroneous data points while minimizing the distortion of the actual
shape of the data profile. The technique involves convoluting a quadratic/cubic or
quartic/quintic function with the data. The selection of quadratic/cubic or quartic/quintic
and the number of points to include in the calculation is accessed from the Settings
command. Interested readers may reference A. Savitzky and M. Golay, “Smoothing and
Differentiation of Data by Simplified Least Squares Procedures,” Analytical Chemistry,
36(8): 1627-1639, 1964.
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The Savitzky-Golay function is disabled when data files collected with the Single Sample
Mode are loaded into the Data Analysis program.  See Chapter 6: Viewing, Analyzing
and Saving Data for further discussion of the Single Sample Mode.

Fluorescence Ratio

The Fluorescence Ratio command calculates a fluorescence ratio according to the
parameters chosen in Settings. You select the filter positions of interest used to derive the
ratio and a background value, if desired. You may also enter a scaling factor in the
Settings dialog box. Select between Counts or Counts/Second to indicate the form of the
background counts entered.

Ion Concentration

The Ion Concentration command calculates an ion concentration based upon the
parameters entered in the Settings dialog box and the data. You may choose a calculation
based upon one fluorescence wavelength according to the formula:

[Ion]= Kd(F-Fmin)/(Fmax-F)

where Kd is the dissociation constant, F is the fluorescence intensity, Fmin is the
fluorescence count at zero ion concentration, and Fmax is the fluorescence count at
saturating ion concentration.

You may choose a calculation based upon two wavelengths according to the formula:

[Ion]= B(R-Rmin)/(Rmax-R)

where B is a constant Kd(Sf2/Sb2), R is the fluorescence ratio of wavelength pairs, Rmin is
the limiting value R can have at zero ion concentration and Rmax is the R at saturating ion
concentration.

Provision is made in the Functions / Settings menu to enter the fluorescence background
before the ratios are calculated. Select between Counts or Counts/Second to indicate the
form of the background counts entered.

The reader may find further information about these formulae and methods in the
publication:

Grynkiewicz G., Poenie M., and Tsien R., “A new generation of Ca2+ indicators with
greatly improved fluorescence properties,” Journal of Biological Chemistry 260(6): 3440-
3450, 1985.

Settings

The Settings command provides access to a dialog box, which contains parameters for
each of the various functions described above. You can select or change parameters as
desired.

A shortcut to the Settings command is available in the toolbar.
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Save Settings

The Save Settings command saves the choices made for the various functions, with the
data file. Settings are saved with the Data Analysis software for later use and are available
the next time the program is used.

Display Menu
The Display menu allows the user to specify the data channels that will be displayed in the
Fluorescence, Analog or Fluorescence Ratio data windows.  The Display menu is
available on the menu bar only when the active window is one of these three data window
types.  Furthermore, the Display menu options vary for each of the three data window
types.  The menu items displayed when Display is selected depend on which data child
window is active.

Fluorescence and Analog Window Display Options

If a Fluorescence or Analog window or is active when Display is selected, then the
following options are available for selection in the Display drop-down menu.

! Channel 1

! Channel 2

! Channel 3

! Channel 4

! Channel 5

! Channel 6

! Channel 7

! Channel 8

! Select All

! Deselect All

The number of channels available depends on the number of channels available in the data
file. This depends on how the data was collected in the Data Acquisition program.

Selecting and Deselecting Channels

Channels can be selected (indicated by a checkmark) or deselected individually by
clicking on the appropriate options.

Selecting Select All selects all Fluorescence or Analog channels.

Selecting Deselect All removes the selection from all Fluorescence or Analog
channels.
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Fluorescence Ratio Window Display Options

If a Fluorescence Ratio window is active when Display is selected, a dialog box appears
that allows you to set the numerator and denominator used to calculate the ratio. This is
the same dialog box you access from the Functions / Settings command.

Ion Concentration Window Display Options

If an Ion Concentration Window is active when Display is selected, a dialog box appears
that allows you to choose wavelengths pairs and background information. This is the same
dialog box you access from the Functions / Settings command.

Window Menu
The following menu items are available in the Window menu:

! New (Fluorescence) Counts

! New Analog

! New Fluorescence Ratio

! New Data Information

! New Statistics

! New Spreadsheet

! Cascade

! Tile

! Arrange Icons

! 1... (etc.)

Window / New Counts, / New Analog,  / New Data Information, New
Statistics, and  / New Spreadsheet

Selecting New (Fluorescence) Counts, New Analog, New Data Information, New
Statistics, or New Spreadsheet, opens an additional Fluorescence, Analog, Fluorescence
Ratio, Data Information, Statistics or Spreadsheet window, respectively. The newly added
window initially inherits default attributes for this type of window. The additional
window, however, can be customized to display data in a fashion that is different from and
independent of other windows of the same type. For instance, two separate Fluorescence
windows can be used to view fluorescence from different filter wheel positions and the
data can be scaled differently in each window. A discussion of the use of Statistics and
Spreadsheet windows can be found in Chapter 6: Viewing, Analyzing and Saving Data.

Window / Cascade

Displays all child windows in a cascade.
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Window / Tile

Displays all child windows in a tile display.

Window / Arrange Icons

Arranges at the bottom of the screen, above the status bar, the icons of all child windows
that have been minimized.

Window / 1... (Etc.)

Changes the active window to the particular window selected from the Window menu list.
This action is analogous to clicking on the title bar of an inactive child window to make it
the active window.

Help Menu
The following options are available in the Help menu.

! Online Manual – PDF

! Online Manual – HTML

! C&L Instruments Website

! About Analysis…

Help / Online Manual – PDF

This option opens a help file as a PDF (Portable Document Format) document.  The PDF
file contains bookmarks to facilitate navigation through the document.  To open this file,
you must have Adobe  Acrobat  or the Adobe  Acrobat Reader  (version 3.0 or greater)
loaded on your computer.  Information about Adobe Acrobat can be obtained from the
Adobe website (www.adobe.com).  This version of the help file is essentially the same as
the HTML version.

Help / Online Manual – HTML

This option opens a help file as an HTML (Hypertext Markup Language) document in
your default web browser application.  This version of the help file is essentially the same
as the PDF version.

Help / C&L Instruments Website

Selecting this option opens your default web browser and loads the home page of the C&L
Instruments Internet website.

Help / About Analysis…

Selecting About Analysis displays on-line information about C&L Instruments, Inc. and
the version information about the Analysis software.
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Toolbar
The Toolbar provides shortcut icons to some common functions such as: Open File, Save,
Print, Circles, Lines, Zoom Range, Zoom In/Out, Move Up/Down and Left/Right, and
Select X, Unzoom, Zoom Settings, and Sync Time.  The use of these icons as shortcuts to
specific menu options is discussed in Chapter 5: Using the Icons in the Toolbar.

Status Bar
The status bar at the bottom of the main program window displays two types of status
messages:

Ready - This is the default status message, which is generally displayed when the program
is ready and able to accept input from the user.

Option description - When the cursor is moved over a drop-down menu option, the status
area displays a brief description of that option.
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Chapter 5: Using the Icons in the Toolbar

Overview
This chapter describes how the icons in the Toolbar can be used as short cuts to save time
when operating the Data Analysis software.  Many of the program selections available in
the main Menu Bar are also available as icons.  The reader is referred to the previous
chapter, Chapter 4: Command Reference for an explanation of the functions represented
by these icons.

The Icons
The following is a list of the icons that are available in the Toolbar, together with the
function they represent.  These functions can also be found in main Menu Bar.

  File / Open   File / Save

  File / Print…   Help / About C&L…

  View / Circles   View / Lines

  View / Zoom > Range   View / Zoom > In

  View / Zoom > Out   View / Move > Up

  View / Move > Down   View / Move > Left

  View / Move > Right   View / Select X

  View / Unzoom   View / Settings…

  View / Sync Time
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Chapter 6: Viewing, Analyzing and Saving Data

Use of Right Mouse Button
When a window with a graph is displayed, such as Fluorescence, Fluorescence Ratio,
Interlace, Analog, or FFT, you can use the right mouse button as a shortcut to get to pull
down menus. When you position the mouse within the graph area and then right click, you
will access the View menu functions that pertain to that window. When you position the
mouse outside the graph area, but still inside the window, and then right click, you will
access the Display menu functions that pertain to that window. These are the same
functions available from the toolbar when the relevant window is active.

Data Windows
The Analysis program can display several types of data windows to facilitate the viewing
and analysis of your data.  These windows are the Fluorescence, Analog, Statistics, Data
Information, FFT, Fluorescence Ratio, and Ion Concentration.  A discussion of the
Fluorescence, Analog, FFT, Fluorescence Ratio, and Ion Concentration windows can be
found in Chapter 4: Command Reference.

The Data Information Window

The data information window illustrates information about how and when the data file
was collected using the Acquisition program. This feature alleviates the user from
manually recording this information about each data file when it is initially recorded.
These data fields cannot be edited by the user, and are presented for informational
purposes only.

The Spreadsheet Window

The Spreadsheet window can be used to visualize and/or change numerical values of the
data. This window is available by selecting Windows / New Spread Sheet in the menu
bar. Shown are the values selected in the ROI data range.

To change a particular data value, double click on a cell containing a data value using the
left mouse button. This will cause a Change Value dialog box to appear in which you can
change a value. To permanently change the data value in the file, you must save the data
using either File / Save or the File / Save As command. This new value will then
permanently replace the prior value in the data file after the file is saved. You may save
the data in a new file to avoid overwriting the original file using the File / Save As
command.
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Figure 8.  The Data Information window illustrating information about the data file
currently loaded into the Analysis program.

Figure 9.  The Spread Sheet window illustrating the data values within the Region of
Interest.
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Figure 10.  The New Value dialog box that appears after double-clicking on a data value
in the Spread Sheet window.

The Statistics Window

Figure 11.  The Statistics window illustrates information about the data within the Region
of Interest.
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The Statistics window automatically opens as a default child window when a data file is
opened in the Analysis program. It can also be opened using the Window / New Statistics
command. Shown in the Statistics window is information about the range of data selected
as the Region of Interest (ROI).  For each Fluorescence and Analog channel, the time
interval, the number of data points selected, the data mean and data standard deviation are
displayed. This feature can be used to quickly obtain the mean value of data over a given
time range. In addition, the regression best-fit line, calculated by least squares analysis,
fitting the ROI region is displayed. This equation can be used to extrapolate the data to any
point in time or to obtain the rate of change  (i.e., the slope) of the data values.

Exporting Data
Several options are available to export data from the Analysis program. Data displayed in
any active data window (i.e., Fluorescence, Analog, Ion Concentration, FFT, Fluorescence
Ratio, and Interlace) can be exported.

Exporting Data using the Copy Command

To export data from a data window, click on the title bar of the data window to make the
window active. Then access the Edit / Copy command. There are three Copy choices,
Copy All, Copy View and Copy ROI (Region of Interest) Copy All copies all the data
pertaining to the active window to the Windows  clipboard, whether or not all the data is
currently displayed. Copy View copies only the data that is displayed in the current view
(i.e., the data that is visible). Copy ROI copies the data from the selected ROI. These
three choices are available for all windows except for the Interlace window, in which only
Copy All is available.

To select an ROI for exporting data, use the View menu and Select X to select a range of
values using the mouse. The ROI selected is indicated as a red bar under the data window.
Information about the selected ROI will automatically appear in the Statistics Window
(time range, number of points, data mean, etc.). This option is also available as an icon in
the tool bar (icon with double horizontal arrows).  You may deselect the ROI by clicking
the left mouse button once, inside the window.  This function makes the entire range of
data the ROI.

These functions copy the data to the Windows  clipboard where it may be pasted into and
used by other programs such as Excel  or a text editor such as Notepad  or Word . Data
is presented as columns of either Fluorescence Intensities or Voltages for each channel.
The data is copied to the clipboard in ASCII CSV (comma separated value) format.

Exporting Data in ASCII Format

The entire data file can be exported as an ASCII file by selecting File / Save As.  This will
display the Save As dialog box.  Click on the Save as type: drop down selection and
chose the CSV format.  Type in a file name and click on the Save button.
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Exporting Data from Files Collected in the Single Sample Mode

The Data Acquisition software program allows the user to collect data in a Single Sample
Mode.  In this mode, single data points may be collected which are not separated by a
constant time interval.  In this case, data displayed in the Fluorescence, and Analog
windows will not contain a time value along the X axis.  In addition, all time related
functions (Downsample, Filter, Interlace and Savitzky-Golay) are disabled.  When these
data are exported using either the Copy command or by saving the file as a CSV file, the
data in the first column will represent the point number rather than a unit of time.

When the Single Sample mode is used to collect data in an automated fashion, in which
data are collected in intervals of 1 minute or more, the time related functions
(Downsample, Filter, Interlace and Savitzky-Golay) are also disabled.  When these data
are exported using either the Copy command or by saving the file as a CSV file, the data
in the first column will be in units of minutes rather than seconds.

Saving Processed Data
You may save the entire data file data by using either the File / Save or File / Save As
command. The Save command overwrites the .flu file with the data in use by the Analysis
program. The Save As command gives you the option of saving the data in .flu format or
.csv (comma separated value) format, as described above. It also allows you to change the
filename so that you do not overwrite your original file. Note that the Analysis program
can only open data files saved using the .flu format.

Figure 12.  The Save As dialog box illustrating the “cvs” file type.



Chapter 7: Troubleshooting

Data Analysis Software User Manual (version 1.1) Page 34

Chapter 7: Troubleshooting
If you have trouble operating the C&L Instruments Dye Fluorometer or Data Analysis
software, please follow these steps.

1. Consult this chapter for answers to common problems.

2. Contact C&L Instrument, Inc.  Contact information is given in the front of this
manual.

Symptom Possible Problem Possible Solution

Main program window opens
without any child windows
and most menu items are
disabled.

A data file has not been
loaded.

Use the File / Open command
to open a data file.

Fluorescence and/or Analog
data is not visible in the
Fluorescence window.

Viewing of Fluorescence data
is not enabled

Make sure the Fluorescence
or Analog window is active,
and then enable viewing of
data using the View menu.

Data is off scale Use the Unzoom feature or
either the Move Up or Move
Down command.

Colors of data point(s) are
the same as the graph
background color.

Change the color of the data
points using the Color…
menu item under Options.

The Zoom In or Zoom Out
feature does not work.

The Zoom setting is set to
zero percent.

Select View / Settings…
when a data window is active
and set the percent zoom
setting to a number above 10
percent.
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Chapter 8: Agreement, License and Warranty

Agreement and License
C&L Instruments, Inc. (“C&L”) provides this instrument, including its software program,
and licenses the use of the software program, according to the following terms and
conditions.

Definitions:

Instrument: The fluorometer provided and any components thereof, not including
any software programs enclosed.

Software: The computer programs enclosed.

Product: All of the materials provided with this License Agreement, including
the fluorometer or any components thereof and/or software.

You may:

(i) use the software program on a single machine;

(ii) copy the software program into any machine-readable or printed form for backup
purposes in support of your use of the software program on the single machine. (Certain
programs, however, may include mechanisms to limit or inhibit copying.  They are marked
"copy protected").

You may not:

(i) modify the software program and/or merge it into another software program for your
use on the single machine without the written consent of C&L;

(ii) transfer the software program and license to another party without the written consent
of C&L.

Copyright Notice

YOU MAY NOT USE, COPY, MODIFY, OR TRANSFER THE SOFTWARE
PROGRAM, OR ANY COPY, MODIFICATION OR MERGED PORTION, IN WHOLE
OR IN PART, EXCEPT AS EXPRESSLY PROVIDED FOR IN THIS LICENSE.

IF YOU TRANSFER POSSESSION OF ANY COPY, MODIFICATION, OR MERGED
PORTION OF THE SOFTWARE PROGRAM TO ANOTHER PARTY, YOUR
LICENSE IS AUTOMATICALLY TERMINATED.

Term

The License Agreement is effective until terminated.  You may terminate it at any time by
returning or destroying the Software together with all copies, modifications and merged
portion in any form.  It will also terminate upon conditions set forth elsewhere in the
Agreement or if you infringe any C&L copyright or any other intellectual property right or



Chapter 8: Agreement, License and Warranty

Data Analysis Software User Manual (version 1.1) Page 36

fail to comply with any term or condition of this Agreement; you agree upon such
termination to destroy the software program together with all copies, modifications and
merged portions in any form.

Limited Warranty
C&L warrants that the Instrument and/or components shall be free from defects, not
including consumables, such as lamps and interference filters, for a period of one (1) year,
following date of purchase when used under normal conditions.  Optics, including lenses
and heat filters are subject to these limited warranties for thirty (30) days.  The neutral
density filter, if provided, is not covered by this warranty.  All repairs must be made by
C&L and Customer must return the Instrument and/or component to C&L, at
customer’s cost, for repair.  Return of the instrument for repair must be
preapproved by C&L.

THE FOREGOING WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES,
EXPRESS OR IMPLIED.  YOU ASSUME FULL RESPONSIBILITY FOR THE
SELECTION OF THE PRODUCT TO ACHIEVE YOUR INTENDED RESULTS, AND
FOR THE INSTALLATION, USE AND RESULTS OBTAINED FROM THE
PRODUCT.

OTHER THAN AS STATED ABOVE, THE PRODUCT IS PROVIDED "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO THE IMPLIED WARRANTY OF
MERCHANTABILITY AND FITNESS FOR PARTICULAR PURPOSE.  C&L DOES
NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE OR
THE INSTRUMENT WILL MEET YOUR REQUIREMENTS OR THAT THE
OPERATION OF THE INSTRUMENT AND/OR SOFTWARE WILL BE
UNINTERRUPTED OR ERROR FREE.  THE ENTIRE RISK AS TO THE QUALITY
AND PERFORMANCE OF THE SOFTWARE IS WITH YOU.  SHOULD THE
SOFTWARE PROVE DEFECTIVE, YOU (AND NOT C&L OR ANY AUTHORIZED
REPRESENTATIVE) ASSUME THE ENTIRE COST OF ALL NECESSARY
SERVICING, REPAIR OR CORRECTION.

THIS PRODUCT IS NOT INTENDED OR SUITABLE FOR USE IN HUMAN
RESEARCH OR FOR DIAGNOSTIC PURPOSES.  C&L DOES NOT
RECOMMEND THE USE OF THIS PRODUCT FOR APPLICATIONS IN
WHICH ERRORS OR OMISSIONS COULD THREATEN LIFE, INJURY OR
SIGNIFICANT LOSS.

Limitation of Remedies

IN NO EVENT WILL C&L, ITS DISTRIBUTORS AND DEALERS BE LIABLE TO
YOU FOR ANY DAMAGES OF ANY KIND OR NATURE, INCLUDING BUT NOT
LIMITED TO, ANY LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL,
CONSEQUENTIAL OR SPECIAL DAMAGES ARISING OUT OF THE USE OR
INABILITY TO USE SUCH PRODUCT, EVEN IF C&L OR ITS AUTHORIZED
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REPRESENTATIVE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY.

United States Federal Government Restricted Rights

If this Software is acquired by or on behalf of the U.S. Federal government, this provision
applies.  Use, duplication or disclosure of this Software is subject to restrictions set forth
in FAR 52 227-19 and DFAR 227 7200-227 7202-1, as applicable.  The Software is
“commercial computer software” and is licensed with only “Restricted Rights.”

General

This License Agreement is your proof of license to exercise the rights granted herein and
must be retained by you.  You may not reverse engineer, decompile, or disassemble the
software.  You may not sublicense, assign or transfer the license or the software except as
expressly provided in this Agreement.  Any attempt otherwise to sublicense, assign or
transfer any of the rights, duties or obligations hereunder is void.  Warranty is void if
instrument, components and/or software is subject to abuse, misuse or unauthorized
modification.

Whenever possible, each provision of this License Agreement shall be interpreted in such
a manner as to be valid and effective under applicable law.  If any provision is found to be
unlawful, void or for any reason unenforceable, then that provision shall be deemed
severable from this License Agreement and shall not affect the validity and the
enforceability of the remaining portions of this License Agreement.  This Agreement will
be governed by the laws of the Commonwealth of Pennsylvania.

Should you have any questions concerning this agreement, you may contact C&L at 314
Scout Lane, Hummelstown, PA, USA, 717-566-3642.

Excel®, Word®, Notepad®, and Windows®, are registered trademarks of Microsoft
Corporation.

Pentium® is a registered trademark of Intel Corporation.

Adobe , Acrobat  and Acrobat Reader  are registered trademarks Adobe Systems
Incorporated.
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